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Navigating

Before Getting Started
This booklet supplies the information you need to navigate the integrated sys-
tem provided in all TNT products. Consult these pages for an introductory survery
of basic system operations.  The TNT products appear with the familiar graphical
user interface of your computer platform (Windows, Mac OS X, and Linux/UNIX)
while at the same time they present an interface that is identical in the essentials
across all computer platforms.  The TNT products have identical features and
interface elements on every computer platform.

Prerequisite Skills This booklet assumes that you have completed the exercises
in the tutorial Displaying Geospatial Data. The exercises in that booklet show
you how to select and view spatial objects stored in Project Files. You should
know how to zoom, pan, and enhance display objects, and how to use the Refer-
ence Manual. This booklet does not present these basic skills again. Please
consult Displaying Geospatial Data for any review you need.

Sample Data  The exercises presented in this booklet use sample data that is
distributed with the TNT products.  If you do not have access to a TNT products
CD, you can download the data from MicroImages’ web site.  In particular, this
booklet uses objects in the BEREAMSS Project File and the CB_DATA data collection.
The installation process makes a read-write copy of these files on your hard
drive; you may encounter problems if you work directly with the read-only sample
data on the CD-ROM.

More Documentation  This booklet is intended only as an introduction to basic
system operations.  Consult the TNT Reference Manual, which includes over 240
pages on basic system operations, for more information.

TNTmips and TNTlite™  TNTmips comes in two versions: the professional ver-
sion and the free TNTlite version. This booklet refers to both versions as
“TNTmips.”  If you did not purchase the professional version (which requires a
software license key), TNTmips operates in TNTlite mode, which limits object
size, and enables data sharing only with other copies of TNTlite.

Basic system operations are common to TNTmips, TNTedit, TNTview, and
TNTatlas.  All exercises can be completed in TNTlite with the sample geodata
provided.

Keith Ghormley,  11 September 2003

It may be difficult to identify the important points in some illustrations without
a color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ web site.  The web site is also your source for the newest
tutorials on other topics.  You can download an installation guide, sample
data, and the latest version of TNTlite:

http://www.microimages.com
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TNTmips is like no other software product in its class;
it has exactly the same features and interface on ev-
ery type of computer: Windows, Mac OS X, and
Linux/UNIX.  The software engineers at MicroImages
maintain exactly one version of their programming
code, and that code is prepared for each type of
computer without modification.  Keeping one set of
code is the only way to ensure that the version of
TNTmips on each
type of computer
is exactly like the
versions on every
other type of com-
puter.  It lets
MicroImages pre-
pare TNT prod-
ucts for release on new platforms easily. As a
MicroImages client, you benefit because the ver-
sion of TNTmips for your computer will never be
orphaned or lag behind when updates and new ver-
sions are released.

MicroImages accomplishes this seamless cross-plat-
form development by using the X Window System
as the system environment for the TNT products.
UNIX computers have X in their basic configura-
tion.  Mac OS X uses Apple's X11 implementation.
For Windows computers, MicroImages supplies MI/
X, our own X Server.  On every platform, X runs as
an environment layer in
the background, so you as
the user can concentrate
completely on your work
in the TNT processes.

The first exercises
(pages 4-6) introduce
some basic X con-
cepts.  Project Files,
object types, naming
and maintenance
procedures are
covered on pages 7-
15.  Other system
basics are covered on
pages 16-23.

The X Window System
supports multitasking,
remote execution, and
display of graphics
generated in one computer
system on another
computer in a network.  X
has strong traditional ties to
UNIX, but can run under any
operating system.

X and the TNT products

For Mac OS X, Apple's
X11 provides the TNT
run environment.

For Windows,
MicroImages
automatically
launches MI/X.  Set MI/X
peferences from the icon in
the Windows system tray.

You can select a Windows
or X desktop interface.
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Windows Interface

X Windows / OSF-Motif Interface

Mac OS X Interface

Host System Differences

You may notice slight differences,
such as the contents of the Window
Menu (if any), and what happens
when you click on the desktop.

(X11 on Mac
OS X has
no window
menu.)

This booklet illustrates its exercises with the Win-
dows interface.  You will notice only slight differ-
ences if you are using Mac OS X or Linux/UNIX.

Some interface elements are
determined by the host op-
erating system.  For example,
Windows and Linux / UNIX
computers put the Minimize,
Maximize, and Close buttons
for each window at the right
end of the title bar, while Mac
OS X puts those buttons on
the left end of the title bar.
These are differences in the
host operating system, not in
the TNT products.

Other difference include the
contents of the Window Menu (if there is one), and
what the operating system does with a mouse click
on the desktop.

Minimize, Maximize, and
Close buttons differ
according to the conven-
tions of the host operating
system.
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TWM with X Windows
If you use the X Windows desktop under Microsoft
Windows (or if you use Linux / UNIX), you will en-
counter the TWM window manager.  The TWM win-
dow menus and the TWM pop-up operations menus
offer several features for managing your work in the
X Window environment.

The TWM window menu opens
when you click the menu icon.

Use the TWM window menu and its cascades to
manipulate window size, order, and position.

Click the right mouse
button on the title bar of
any window to LOWER it.

Click the left mouse button on the
title bar of any window to RAISE it.

Click on an iconified
window to restore it.

You can show or
hide an Icon Manager
bar that offers a
control icon for each
active process.

Keyboard focus follows the
mouse in TWM.  But you can
anchor keyboard focus to a
selected window so that even
if you move the mouse
somewhere else, the
keyboard input is still directed
to the same window.

If for some reason a process
stops responding, you can
force it to close with the TWM
Close Window or Kill Process
operations.

Left-click pop-up:
The right-click
menu can be
expanded and
customized by
editing the
TNTSERV.TWM file in
the TNT products
home directory.

Right-click pop-up:Click on any unused part of
the desktop to open the TWM
pop-up operations menus.

RAISE and LOWER
operations are apparent
only when there are
overlapping windows.
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Interface Vocabulary
The TNT products provide a consistent and recog-
nizable style for interface elements such as scroll

bars, check boxes and menu cascades.
This consistentcy makes you instantly
familiar with the interface components
when you go to a different computer. The
Reference Manual, tutorial booklets, and
other documentation uses a carefully de-

fined vocabulary to refer to the elements of the
graphical interface. Review the basic terms, con-
cepts, and appearance of the interface elements pre-
sented on this page.

title bar

window menu

menu bar

toggle button (on)

option button

inactive feature
(grayed out)

action button
(also
push button)

minimize button maximize button

close button

tool bar

tabbed panels

layers list

tool tip

icon buttons

text box

slider
A long slider

indicates that
most of the

list or image
is in view.  A
short slider

indicates that
much of the

list or image
is out of view.

scroll arrow

toggle button (off)

A Dialog Box is a window
that offers response push
buttons, such as [OK],
[Cancel], and [Help]
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The Project File
An object is one complete
data entity in a Project File
that all the TNT products
handle as a unit, like one
airphoto scan (raster), or
one imported CAD file.  A
subobject is attached to
an object and contains
supplemental material, like
color display information or
georeference data.  You
may have as many Project
Files as the capacity of
your storage devices
allows.

A Project File may contain
multiple levels of nested

folders and virtually
any number of
objects.

TNT products use a single data structure, the Project
File, that can hold all of your project materials.  Any
combination of raster, vector, CAD, TIN, region, text,
and database materials can be kept in each Project
File, so all of your data that pertains to a project or
task can be kept together easily.  The Project File
was designed with cross-platform users in mind.  The
TNT processes all use special read and write rou-
tines so that any single TNT Project File can be
used interchangeably by any kind of computer: Win-
dows, Macintosh, or UNIX.  From your point of view,
all cross-platform conversion and translation issues
are automatic and transparent.

The free TNTlite product differs from the TNT pro-
fessional products in three ways:

1 Object Size.  TNTlite is limited in the size of the
Project File objects it can use.

2 No Export.  Data Export is disabled in TNTlite.

3 No Return.  TNTlite can use Project File materi-
als prepared by the TNT professional products,
but the TNT professional products cannot use
any object that has been edited or otherwise
modified by TNTlite.

Except for the object size, export, and “no return”
limitations, the free TNTlite product and the TNT
professional products are identical.

Project Files

Folders

Object

Locked Files:  When TNT
opens a Project File, the
system LOCKS the file from
other users and processes
to protect it from simulta-
neous updates.  If your
computer gets turned off or
otherwise interrupted while
a Project File is open, the
.LOK file that TNT uses for
locking will not be erased
as it should.  As a result,
the next time you try to
open that Project File, the
system will see the .LOK
file, assume that it is in use,
and report to you that the
file is locked.  In such as
case, you can delete the
.LOK file as you would any
other unwanted file on your
computer.
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Raster Objects

Raster objects in TNTlite are
limited to 314,368 cells with
1024 as the maximum
dimension.  Thus 1024 x
300, 614 x 512, and 300 x
1024 all fit the TNTlite limits.

The window shows the numeric cell values for part of  the 8-bit grayscale raster
object illustrated.  The letter “Z” which shows in a soil type label in the image can be
visually distinguished in the numeric array by the lower cell values.

Techniques for displaying
raster objects in color,
pseudo-color, and en-
hanced grayscale are
presented in a later
exercise.

display and examine the
SHEET45_LITE raster
object in the LANCSOIL

Project File from the
EDITRAST collection

A raster object is a two-dimensional numeric array
that contains values of a single data type.  Each
number in the raster object represents the value of
some spatial parameter, like spectral reflectance, im-
age color, elevation, type of ground cover, or chemi-
cal concentration.  Cell values in a raster object are
used to control the color and intensity of pixels on a
display screen.  When the dimensions of a raster
object exceed the resolution of the display, the im-
age can be zoomed or scrolled to accommodate the
size difference.

The Examine Cell Values feature is available from
the Tools icon menu in the layer list of the display
process.  You can use Examine Cell Values to view
the numeric cell values that correspond to the raster
display.

Cell data type refers to the number of storage bits
assigned to each cell.  Raster object cells can have
data types of 1-bit (binary), 4-bit, 8-bit, 16-bit, 32-
bit, or 64-bits of either integer or real number values.
128-bit raster objects are supported for special pro-
cesses that deal with the real and imaginary compo-
nents of complex numbers.
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Vector Objects
display and examine the
PARCEL vector object in
the BLACKBRN Project File
from the BLACKBRN

collection

Vector objects in TNTlite are
limited to 1500 lines, 500
polygons, and 1500 points.

A vector point element is
defined by x,y or x,y,z
coordinates.

A vector polygon element consists of one or
more line elements that define a closed shape.

A vector node element terminates
one end of a line element.

A vector line element
has a node at each end.

A vector object is the collection of vector elements
(points, lines, polygons, nodes, and labels) and at-
tributes stored together in a TNT Project File.  Points,
lines, and polygons can be assigned to classes, have
attached database records, and be displayed in a
selected drawing style (such as point symbols, line
patterns, and polygon fill patterns).

Processes that manipulate and analyze vector ob-
jects can do so only with vector objects that have a
consistent and complete topology. The TNT prod-
ucts automatically enforce one of three levels of vec-
tor topology.  Polygonal topology is the most rigor-
ous level, ensuring that a point lies in at most one
polygon, and that no two lines intersect.  Automatic
topology maintenance requires a certain amount of
internal bookkeeping about the relationship of vec-
tor elements to one another, including
• which lines emerge from a particular node,
• what polygon elements are on either side of a

line element,
• which line elements form a particular polygon,
• which polygons are islands within other poly-

gons, and
• what polygons they are islands within.

Vector topology does not support the idea of “lay-
ered elements” as CAD topology does.

The TNT products support
three levels of vector
topology: Polygonal,
Planar, and  Network.  For
more information on the
levels of vector topology
supported by the TNT
products, refer to the TNT
Reference Manual.
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Types of CAD elements
include: points, circles,
arcs, arc chords, lines,
boxes, polygons,
ellipses, elliptical arcs,
arc wedges, elliptical
arc wedges, elliptical
arc chords and text.
Individual CAD elements
can be organized into
blocks that are inserted at
one or many positions
within a single object.

display and examine the
FOOTPRINT CAD object in
the BLACKBRN Project File
from the BLACKBRN

collection

CAD objects in TNTlite are
limited to 500 elements.

A CAD object has a free-form topology, and is use-
ful for applications that do not require an exact
record of the spatial relationships between an
object’s elements.  The CAD object data structure
does not reconcile line intersections or polygon
overlaps and islands, and thus supports the con-
cept of layered elements.  That is, you can move
CAD elements around in a drawing without trigger-
ing the topological reconciliation of overlapping el-
ements.

The CAD object data structure also allows for the
geometric description of elements.  For example, in a
vector object, an element that appears to be a circle
is actually always a polygon, so that at a high
enough magnification, the circular shape resolves
into discrete vertices and line segments.  By con-
trast, a circle in CAD object is defined by its center
point and radius.  Thus, at any magnification, a CAD
circle looks circular.  Unlike a vector polygon, it can
be resized simply by changing its radius, or moved
by changing the location of its center point.

CAD Objects

Lines may overlap without
explicit intersections in CAD
objects.  (By contrast, in vector
objects, nodes are imposed to
reconcile intersecting ele-
ments.)
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display and examine the
TINLITE TIN object in the
TINLITE Project File from
the SF_DATA collection

A TIN object in a normal 2D view.

A 3D Perspective view.

TIN objects in TNTlite are
limited to 1500 nodes.

TIN Objects
A TIN, or Triangulated Irregular Network, is com-
posed of node and line data that represent a surface
as a set of adjacent, conterminous triangles con-
structed from irregularly spaced three-dimensional
points.  The topology of a TIN object is more restric-
tive than that of vector objects because in a TIN,
every node is part of some polygon, and every poly-
gon is a triangle.  The TIN structure is carefully de-
fined so that for any set of nodes in 3D space, there
is only one TIN that connects all the nodes.  The
minimal size and uniqueness of TIN objects make
them ideal for processes that treat 3D surfaces.

TIN objects can be displayed in 2D or in 3D Per-
spective as a three-dimensional surface.
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Region Objects

The GeoToolbox tool in the
display process lets you
select or create a region
object and then apply it to
elements in the active layer.
The illustration shows a
selection of polygon
elements that are partially
inside the region.

A 400-mile circular region is
centered over Nebraska.

Region objects in TNTlite
have no explicit limits since
they are useful only in
conjunction with other
objects (which already
have TNTlite limits).

In the GeoToolbox window (see page 20 in this booklet), the select operation uses a
region object to select polygon elements in a vector object of U.S. counties.

A Region Object is a special type of polygon con-
struct that defines a complex collection of areas (in-
cluding any islands) and stores it in a map projec-
tion. Regions can be created in display processes
and in the Object Editor by generating them over a
georeferenced image.  Once defined, a region can
be used as a control object in other processes: for
element selection or area definition for processing,
or in the application of other geospatial manipula-
tions and analyses.

Region objects are useful only in conjunction with
other geospatial objects (raster, vector, CAD, TIN,
and database); they have no particular usefulness
by themselves.  Region objects are particularly use-
ful in Element Selection operations, which are intro-
duced on page 20.

The illustration on this page shows a U.S. counties
vector object with polygon elements selected by a
region object with a 400-mile radius.

Look for more information in
the tutorial booklet Interac-
tive Region Analysis.
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Database Objects
Database objects in TNTlite
are limited to 1500 records.

Select an element by clicking on a
record in the database window.

Open a database window
by pushing its icon button in
the layer list.

TNT database objects can store both direct geospa-
tial data and related reference information for other
Project File objects.  Database files can be linked or
imported either as primary objects for direct use, or
as subobjects that contain data cross-referenced to
elements in raster, vector, CAD, or TIN objects.  Da-
tabases can be linked to a Project File either through
ODBC (Open Data-
base Connectivity), or
with direct support for
particular formats.

Database objects can
be manipulated
relationally, that is, a
field in one table can
index a record in an-
other table.  Thus, a chain of relational links can be
established whereby an element references a record
containing field(s) tied to records in other tables.
Records in more than one table can also be attached
to a single element.  Complex logical constructs can
be applied to values in multiple databases to govern
selection and processing operations “by query” in
many TNT processes. Select a record by clicking on

an element in the display.
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STEPS
in the Display /
Spatial Data
process, open
LITEDATA / BEREA / LAYOUTS /
LAYOUT1
choose Save As from
the Layout menu in the
Layout Controls
window
navigate to the file
level and click the
New File icon button
type in a file name and
description and click
[OK]
click the New
Object icon button
type in an object name
and description
click [OK] to complete
the operation

File and Object Naming
If you have a large collection of project materials,
you need to follow a good organization and naming
practice.  Use descriptive names and give a clear
description with each name.

Project File names may be fifteen characters long
and always use “rvc” as the file extension.  Note
that you may need to tailor your file names to com-
ply with the limitations of your operating system
and network environment.  (Special characters al-
lowed by one system may be illegal in another.)

The names of folders, objects, and subobjects in a
Project File may be 15 characters long with an op-
tional 63-character description.  Object names must
be unique for each object type within a folder.  Simi-
larly, subobject names must be unique within an
object.  Folders, objects, and subobjects can be
copied, renamed, and erased with the Project File
Maintenance process (Support / Maintenance /
Project File) described on the next page.

Click the New File icon button to
open the New Project File
window where you can name
(15 characters) and describe (63
characters) a new Project File.

Click the New Object icon
button to open the New
Object window where
you can name and
describe a new object.
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STEPS
select Support /
Maintenance / Project
File from the main menu
select any object from
any Project File
click the Info icon
button and examine
the Object Information
window

••••• Break Lock
releases the write
lock on a Project File.

••••• Delete removes an
object.

••••• Link To lets you link
to read-only objects
and have read-write
subobjects.

Project File Maintenance
A Project File is a single data structure organized in
a multi-level, logical hierarchy that may contain ras-
ter, vector, CAD, database, region, and TIN objects
and subobjects. During the course of your work,
you may have occasion to copy an object from one
Project File to another, or perform other maintenance
functions. To access Project File Maintenance, se-
lect Support / Maintenance / Project File from the
menu.  The Project File Maintenance  window opens
and displays a list of directories and files. Mainte-
nance operations are applied to the currently se-
lected item with the push buttons at the bottom of
the window.

Use the Info button to get general information, such
as an object’s type, source, and a list of attached
subobjects.  The Edit button lets you modify the
item’s name and description and some other things,
depending on the type of object.  For example, you
can use Edit to change the assigned Null value and
cell size for a raster object.

The Info push button
opens the Object
Information window.

Apply an operation to the
currently selected item with
an icon button.

Double-click on an item
in the selection list to
move to the next level
of the Project File.

You can save the
contents of the object
information window
to a text file.
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(1) A simple grayscale spread
from 0 (black) to 255 (white);

(2)  A rainbow color spread that
traverses the color space from 0
(violet) to 255 (red);

(3) A two-range color spread:
from 0 to 122 (dark green to
green), and 123 to 255 (olive drab
to yellow).

Three color tables applied to the same 8-bit elevation raster object.

STEPS
display the ELEVATION

raster object from the
CB_TM Project File in the
CB_DATA collection
select Edit Colors
from the Tools icon
drop-down menu
select Rainbow from the
Palette menu in the Color
Palette Editor window
experiment with
color spread and
editing tools and click
Redraw in the View
window

Color Maps
A raster object is a two-dimensional array of num-
bers.  Display processes use the values in the rows
and columns of a single raster object such that the
color and intensity of each image display pixel is
determined by a corresponding cell in the raster
object.  A variety of techniques are used to create
grayscale and color images from the cell values in
one or more raster objects.

A color map (also color table) associates 8-bit ras-
ter data values (0-255) with various display colors.
The Edit Colors selection on the Tools menu opens
a Color Palette Editor window where colors can be
adjusted, and complete color spreads applied.

1

2

3

2 31

Look for more information in the tutorial booklet Getting Good Color
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STEPS
display the RED raster
object from CB_TM in the
CB_DATA collection
select Enhance
Contrast from the
Tools icon menu
experiment with
contrast editing

In this image, the cell values
range from 20 to 164.

A normalized contrast
improves the appearance.

In User Defined mode, you can use freehand
drawing techniques to reshape the contrast curve.

Contrast Tables

Drag the statistical
control components
in the top panel of
the window.

To improve display appearance, the TNT display
processes apply contrast enhancements to grayscale
images.  The display processes can use an existing
contrast table or they can create one.  A contrast
table can project a narrow range of cell values into a
wide range of display intensities, making the brights
brighter and the darks darker for better visual ap-
pearance.

You can adjust the visual appearance of grayscale
images by creating and selecting different meth-
ods of contrast enhancement.  The display pro-
cesses let you choose from linear, normalized, equal-
ized, exponential, and user-defined translation
curves.  The Enhance Contrast selection on the
Tools icon drop-down menu opens a Raster Con-
trast Enhancement window where you can select
or interactively create a contrast curve.  Make the
adjustments you want and click Redraw to see the
effect.

A narrow input/output range puts
more cells at the extremes.
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Icon Buttons and ToolTips

Vocabulary: An Icon
Button is a graphical push
button that activates a
program function.  A
ToolTip is a label for an
Icon Button that appears
after you pause the mouse
cursor over an icon button.

Pause the mouse cursor
over an icon button to
expose its ToolTip.

ToolTip text disappears
automatically when you
move the mouse cursor
away from its icon button.

Some complex programs that offer many menu and
button choices tend to crowd the screen with text
and labels.  In order to reduce this kind of interface
clutter, the TNT products employ icon buttons,
which provide a graphical representation of the
button’s function instead of space-consuming la-
bel text.  Icon buttons take less interface space, so a
window can present more functions at the main level,
letting you apply operations without working
through several levels of cascading menus and pro-
gram dialogs.

Some standard icons are widely used by other popu-
lar computer software, and such icons are instantly
familiar to experienced users.  The TNT products
use such “universal” icons when possible.  How-
ever, many functions in TNT processes use unique

icons designed spe-
cifically by MicroIm-
ages.  Use the
ToolTip feature to
display a temporary
label that describes
the icon button’s
function.  Position
the mouse cursor
over the icon button.

Whenever the mouse cursor pauses over an icon
button, a ToolTip identifier pops in, naming the func-
tion of the icon button.

Icon buttons in the Display
Spatial Data window
provide quick access to
program functions and
object controls.

Icon buttons appear in the
menu bar and also in the
layer list of the display
process.
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Custom Toolbars

Design your own toolbars,
by picking an icon and
assigning label text to each
process you select.

TNT provides customizable tool-
bars so that your favorite pro-
cesses and SML scripts can al-
ways be instantly available.  You can create a toolbar
with as many processes as you like on it, and there-
after access each process with a single click.  Launch-
ing a process with one click from a toolbar is easier
than navigating through a series
of cascading menus to find the
process you want.  For example,
to use Feature Mapping, you
could navigate four levels of menu cascades for the
process (Process / Raster / Interpret / Feature Map),
or you could simply click the Feature Mapping icon
in your custom toolbar.

You can create as many different custom toolbars as
you like and have any number of tool bars open at a
time.  You can create your tool bars with labels, and
later turn off the label display after you are familiar
with the icons.  In any event, ToolTips are present
automatically over every process-level toolbar icon.

To create a toolbar, select Edit from the Toolbars
menu. The controls in the top panel of the Toolbar
Editor window let you
create and delete
toolbars.  Select a pro-
cess from the scrolling
list on the left, and add it
to the process list on the
right.

Choose a process icon,
label, and ToolTip text.

Pick a toolbar from the list to
modify the selection of
processes it contains.

Select processes and add
or remove them from a
toolbar’s Selected
Processes list.

Select toolbars from the
Toolbars menu.
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STEPS
display HYDROLOGY from
CB_DLG in the CB_DATA

collection
zoom in on the two
small lakes in the
northwest corner as
illustrated below
click the Select tool
in the Control
window
select both lakes
and the hydrology
that connects them in
the View window
click Create Region
/ Buffer Zone,
enter the values
illustrated below, and
click [Apply]

The Create Region
icon opens the Buffer
Zone Region
Generation window.

Element Selection
In many TNT processes, you will want to apply cer-
tain operations to selected elements only.  For ex-
ample, you may want to select a single polygon ele-
ment to view its attached database records, or to
select multiple line and polygon elements to create a
buffer zone around them. Element selection is con-
trolled with tools in the View and Controls windows.
Follow the steps listed for this exercise to use the
interactive buffer zone tool: just one application of
the flexible Element Selection controls.

Other Element Selection features are available in the
GeoToolbox window.  Click the GeoToolbox icon on
the menu bar in the View window and inspect the
selection, measurement, and region tools in the
GeoToolbox window.  Refer to the TNT Reference
Manual for more information about the powerful and
flexible selection features in TNTmips.

Coordinated use of
tools in the View,
Controls, and Buffer
Zone windows
make complex and
powerful element
selection possible.

The Select tool in the
View window lets you
pick multiple elements
from the HYDROLOGY

vector object.

The Select tool in the
Controls window
enables the multiple-
element selection mode.
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Refer to the Getting Started
booklet Understanding Map
Projections.

For best results:
• Keep all related project

materials in the same
map projection.

• If visual discrepancies
persist, resample raster
objects to the geometry
of the map projection.

STEPS
display the STATES vector
object from the UNTDSTAT

Project File in the USA

data collection
select Projection /
Clipping from the Group
menu
In the Group Settings
window, change
Automatch to None
click [Projection...] and
choose a different
System

Map Projections

Your choice of map projection affects the geometry of the display.

In order to draw portions of a spherical surface on a
flat page or display, the surface must be geometri-
cally projected onto the drawing plane.  Many tech-
niques for projecting portions of the earth’s surface
onto planar maps have been defined over the years.
The choice of a map projection determines the ap-
pearance and map qualities of the results you pro-
duce.

For many applications, particularly when the extent
of the project area is local (rather than regional or
continental), the choice of a map projection makes
little visible difference: the curve of the earth’s sur-
face is too slight to matter for short distances.  But
even at local scales, mixing project materials of dif-
ferent geometry can result in layers that “don’t
match” other layers.  The TNT display processes
automatically reconcile different map projections on
the fly, but some factors remain that may affect the
alignment of features and overlays.

If you want to be more than a casual bystander in
the profession of GIS and cartography, you need to
develop a strong grasp of the fundamentals of map
projections so that you can make informed choices
for your mapping projects.

Large-extent
materials show big
differences of
geometry caused by
map projection.

Misapplication of
map projections and
parameters can
cause unwanted
distortions.
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Display a map with line
styles for rivers and
different types of roads.

Choose By Attribute in a
display process to choose
from (or create) a selection
of drawing styles.

Point, line and polygon elements in vector
and CAD objects can be displayed in an
endless variety of drawing styles.  For ex-
ample, you could make points display as oil
well symbols, lines with highway patterns,
or polygons filled with repeating geologic
symbols.  You can select styles explicitly,
or you can use values from attached data-
bases to determine style selection “by at-

tribute.”  To get an idea about style operations:

Style Selection

display the LITEDATA / BEREA / BERVECT / TIGERBEREA vector
object
open the Vector Layer Controls dialog and in the
Lines tab, select Style: By Attribute, and [Specify...]
in the Assign Styles by Attribute dialog, click [Edit
Styles...]
in the Style Editor dialog, select a pattern sample
and then click the Create or Edit Pattern icon
button
in the Line Pattern Editor window, click the Open
icon button
in the Select Pattern dialog, select a pattern to open
and click [OK]
survey the tools in the Line Pattern Editor window

Obviously, TNTmips offers a rich feature set in sup-
port of style selection and design.  For more infor-
mation, refer to the Online Reference Manual or the
tutorial booklet Creating and Using Styles.

Refer to the tutorial
Creating and Using
Styles.
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STEPS
open a new display
group and add CB_DATA /
CB_COMP / _8_BIT, CB_DLG /
HYDROLOGY, and CB_DLG /
ROADS

select Open 2D View
from the Group menu in
the Group Controls
window
turn off the GeoLock
toggle in the View menu
of one of the View
windows
apply different view
controls and tools to
View 1 and View 2
experiment with
the Hide/Show
icons for each layer
and view

Group 1
cb_tm  satellite image
cb_dlg  vector layers

Multiple Views and Groups
The display processes let
you select and arrange com-
plex views of your spatial
data.  A Group can contain
many Layers of geospatial
objects.  When you create a
group, it has one View win-
dow.  You can open more view windows and ma-
nipulate the controls for each View separately, to
give you multiple views of the geospatial objects in
that Group.  You can turn off certain view windows if
you want to focus your work on one View

The complex capability of the display process is
compounded when you realize that you can also
open more than one Group:  multiple Groups, with
each Group visible in multiple Views.  Even more
complexity is possible inasmuch as a View can be
either 2D or 3D.

If you have a single monitor on your computer, you
can quickly fill it with so many Groups and Views
that the result is confusion.  If your computer is
configured with multiple monitors, you can drag
multple Groups and Views to different monitors and
spread out your work.

View 1
1X zoom
measure-
ment tools

View 2
4X zoom
GPS input

Group 2
cb_spot satellite image

cb_elevation surface layer

View 1
2D View

3D viewpoint
tools

View 2
3D view

You can open multiple Groups, and look at each
Group with multiple Views.

The Hide/Show icon toggles
the display of each layer in
each View.

Refer to the
tutorial 3D
Perspective
Visualization.
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Voice: (402)477-9554
FAX:  (402)477-9559

MicroImages, Inc. publishes a complete line of professional software for
advanced geospatial data visualization, analysis, and publishing.  Contact us
or visit our web site for detailed product information.

TNTmips TNTmips is a professional system for fully integrated GIS,
image analysis, CAD, TIN, desktop cartography, and geospatial data-
base management.

TNTedit TNTedit provides interactive tools to create, georeference,
and edit vector, image, CAD, TIN, and relational database project
materials.  TNTedit can access geospatial data in a wide variety of
commercial and public formats.

TNTview TNTview has all the same powerful display features for
complex visualization and interpretation of geospatial materials as
TNTmips. TNTview is perfect for those who need flexible access to the
TNT project materials but do not need the technical processing and
preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project
materials on CD-ROM at low cost. TNTatlas CDs contain multiple
versions of the TNTatlas software so that a single CD can be used on
any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or
on your intranet.  Navigate through massive geodata atlases with your
web browser by using the free, open-source TNTclient Java applet (or
any custom applet you create) to communicate with TNTserver.

TNTlite TNTlite is a free version of TNTmips, TNTedit, and
TNTview for students and professionals with small projects. You can
download TNTlite for your computer (about 100MB) from MicroImages’
web site, or you can order TNTlite on CD-ROM (shipping charges
apply).

email: info@microimages.com
Internet: www.microimages.com

11th Floor – Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010 USA
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